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LEIA COM ATENÇÃO AS INSTRUÇÕES,
1 Confira atentamente se os seus dados pessoais e os dados identificadores do cargo/especialização para o qual 

você concorre, transcritos acima, estão corretos e coincidem com o que está registrado em sua folha de 
respostas. Confira também o seu nome e o nome do cargo/especialização para o qual você concorre em cada 
página numerada deste caderno de provas. Em seguida, verifique se ele contém a quantidade de itens indicada em 
sua folha de respostas, correspondentes às provas objetivas. Caso o caderno esteja incompleto, tenha qualquer 
defeito, ou apresente divergência quanto aos seus dados pessoais ou quanto aos dados identificadores do 
cargo/especialização para o quai você concorre, solicite ao fiscal de sala mais próximo que tome as providências cabfveis, 
pois não serão aceitas reclamações posteriores nesse sentido.

2 Quando autorizado pelo chefe de sala, no momento da identificação, escreva, no espaço apropriado da folha de 
respostas, com a sua caligrafia usual, a seguinte frase:
O ser humano cria a própria saúde ou a própria doença.
Conforme previsto em editai, o descumprimento dessa instrução implicará a anulação das suas provas e a sua eliminação 
do concurso.

3 Não se comunique com outros candidatos nem se levante sem autorização de fiscal de sala.
4 Na duração das provas, está incluído o tempo destinado à identificação — que será feita no decorrer das provas — e ao 

preenchimento da folha de respostas.
5 Ao terminar as provas, chame o fiscal de sala mais próximo, devolva-lhe a sua foiha de respostas e deixe o local de provas.
6 A desobediência a qualquer uma das determinações constantes em edital, no presente caderno ou na folha de respostas 

poderá implicara anulação das suas provas.
OBSERVAÇÕES

Não serão objeto de conhecimento recursos em desacordo com o estabelecido em edital.
Informações adicionais: telefone 0(XX)61 3448-0100; ln tem et-www.cespe.unb.br.
É permitida a reprodução deste material apenas para fins didáticos, desde que citada a fonte.
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De acordo com o comando a que cada um dos itens a seguir se refira, marque, na folha de respostas, para cada item: o campo designado 
com o código C, caso julgue o item CERTO; ou o campo designado com o código E, caso julgue o item ERRADO. Para as devidas 
marcações, use a folha de respostas, único documento válido para a correção das suas provas.

CONHECIMENTOS BÁSICOS
Texto para os itens de 1 a 17

1 A violência instalada nas grandes cidades levou
muitos brasileiros a fazer o caminho oposto ao dos 
antepassados. Em busca de melhor qualidade de vida, eles

4 abandonaram as capitais e os centros urbanos. Instalaram-se em 
urbes do interior que, ao longo dos últimos anos, atraíram 
investimentos e ampliaram o mercado de trabalho. Ali, os

7 novos moradores poderiam usufruir do conforto urbano aliado 
à tranqüilidade decorrente da garantia de segurança.

Levantamento do Mapa da Violência mostrou que o
10 cenário pacífico ficou no passado. Divulgado no dia 30 de

março pelo Instituto Sangari, o documento prova que a 
criminalidade mudou de endereço. Migrou das capitais e

13 regiões metropolitanas para o interior. Em 10 anos, cresceu o 
número de homicídios. Em 1997, a média era de 13,5 
assassinatos para cada grupo de 100 mil pessoas. Em 2007, a 

w cifra saltou para 18,5.
Mais: os dados reforçam tendências que vêm causando 

crescente apreensão às autoridades atentas à evolução do perfil 
19 da violência no país. Um deles: aumenta o número de

homicídios entre jovens. Em 1980, eram 30 casos para cada 
100 mil habitantes. Em 2007, nada menos que 50,1. Outro:

22 homens são vítimas preferenciais —  90% das ocorrências.
Mais uma: os negros lideram o ranque dos mortos —
incremento de 2 1 % em relação às estatísticas dos períodos

25 anteriores.
As informações do Mapa da Violência permitem 

extrair conclusões e sugerir medidas. “O sapo”, escreveu
28 Guimarães Rosa, “não salta por boniteza, mas porém por

precisão” . O mesmo ocorre com a bandidagem. Criminosos 
buscaram novos abrigos porque os antigos não mais lhes

31 oferecem as condições de que precisam. O Plano Nacional de
Segurança Pública e o Fundo Nacional de Segurança 
implementaram ações eficazes que dificultaram a

34 movimentação do crime organizado. Entre elas, o
aparelhamento dos sistemas de segurança pública nos grandes 
conglomerados.

37 O combate a malfeitores não se deve restringir às
metrópoles. Deve, para atingir o fim a que se propõe — 
erradicar o crime ou reduzir os casos a níveis civilizados — , 

4o estender a guerra aos novos territórios. Além de medidas
repressivas, impõem-se iniciativas preventivas. Sem isso, os 
novos mapas a serem divulgados nos próximos anos mostrarão

43 a troca de seis por meia dúzia. Em vez de diminuir a ocorrência
nacional do crime, indicarão apenas a mudança de endereço.

C r im e  m u d a  d e  e n d e r e ç o , br. C o rre io

B r a z ilien se , l . ° / 4 /2 0 l0 ,  p. 2 2  (c o m  a d a p ta ç õ e s ) .

Julgue os itens que se seguem, relativos às ideias do texto.

1 De acordo com o texto, cidades pequenas são locais atraentes 
para investidores e oferecem amplo mercado de trabalho.

2 O nível de criminalidade cresceu nas cidades interioranas em 
virtude das dificuldades encontradas, nas grandes cidades, 
pelos transgressores da lei.

3 De um lado, o cenário atual da violência tende a piorar a 
vulnerabilidade de três grupos sociais: o dos jovens, o dos 
homens e o dos negros; de outro lado, esse fenômeno deve 
levar à diminuição de atos violentos contra as mulheres.

4 O texto mostra que o crime organizado nas metrópoles 
diminuiu desde que o Plano Nacional de Segurança Pública e 
o Fundo Nacional de Segurança puseram em prática medidas 
coercivas.

5 Segundo o texto, impedir os crimes previamente é uma medida, 
no mínimo, tão necessária quanto repreender os criminosos.

Com relação à estrutura do texto, julgue os próximos itens.

6 Com exceção de “atraíram” (f.5) e de “ampliaram” (16), todas 
as formas verbais do primeiro parágrafo fazem referência a 
“muitos brasileiros” (12).

7 Os termos “Um deles” (119) e “Outro” (121) referem-se a 
“os dados” (117).

8 Os termos “antigos” (130) e “grandes conglomerados” 
(135-36) retomam a ideia de “as capitais e os centros 
urbanos” (14).

9 O trecho “estender a guerra aos novos territórios” (140) pode 
ser alterado para estender os novos territórios à guerra sem 
se prejudicar a correção gramatical e o sentido original do 
período.

Com relação à pontuação empregada no texto, julgue os itens
seguintes.

10 Na linha 3, a substituição do ponto que finda o primeiro 
período por dois-pontos mantém a correção gramatical do 
texto, desde que se altere a inicial de “Em” para minúscula.

11 Na linha 5, do ponto de vista gramatical, seria correto o 
deslocamento da vírgula que sucede a palavra “que” para 
imediatamente após o vocábulo “interior” .

12 A correção gramatical do texto seria mantida caso o trecho 
“Divulgado no dia 30 de março pelo Instituto Sangari” 
(110-11) fosse deslocado para depois da expressão 
“o documento” (111) da seguinte forma: O documento 
divulgado no dia 30 de março pelo Instituto Sangari.
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Com referência à concordância e à regência verbal e nominal
empregadas no texto, julgue os itens a seguir.

13 Na linha 17, a locução “vêm causando” apresenta concordância 
de número com o seu respectivo sujeito, “os dados” .

14 No trecho “vêm causando crescente apreensão às autoridades” 
(Í.17-18), a ocorrência do acento grave deve-se à regência de 
“apreensão” .

15 Em “autoridades atentas à evolução do perfil da violência no 
país” (í. 18-19), o termo “à” poderia ser substituído, sem prejuízo 
gramatical ou de sentido para o texto, por para a.

Com referência ao vocabulário do texto e à ortografia, julgue os itens
subsequentes.

16 No texto, a expressão ‘por precisão’ (0 8 -2 9 )  apresenta sentido 
equivalente a com perfeição.

17 A substituição do vocábulo “malfeitores” (137) por celerados 
mantém o sentido do texto.

Julgue os itens seguintes, relativos à redação de correspondências
oficiais.

18

19

20

Certa empresa possui dispositivos para evitar que seu sistema de 
informação seja invadido por pessoas não autorizadas a acessá- 
lo. Apesar disso, para cada tentativa de invasão, a probabilidade 
de sucesso é igual a 0,01. Sucesso é o evento que representa a 
situação em que o sistema é invadido. A partir dessas 
informações, julgue os itens a seguir.

27

28

29

30

Os princípios que regem a redação de correspondências oficiais 
favorecem a existência de uma única interpretação para o texto 
do expediente, assim como asseguram impessoalidade e 
uniformidade no trato dos assuntos concernentes aos órgãos 
governamentais.
O nível de linguagem utilizado em atos e expedientes oficiais 
encontra justificativa no seu caráter público e no fim a que eles se 
destinam, além da obrigatoriedade de que sejam inteligíveis para 
qualquer público.

Um texto de redação oficial deve ser redigido com vistas a evitar 
a prolixidade.

Certa empresa, em determinado mês, realizou levantamento acerca da 
quantidade diária de acessos simultâneos ao seu sistema, cujo 
resultado é mostrado na figura acima. A partir das informações 
apresentadas nessa figura, e considerando que a distribuição da 
quantidade diária de acessos simultâneos é representada pela 
variável X,  julgue os itens que se seguem.

21 A quantidade de 6 mil acessos simultâneos por dia representa a 
moda de X.

22 O mês em que esse levantamento foi realizado possui mais de
30 dias.

23 A quantidade de 2.000 acessos simultâneos diários representa o 
primeiro quartil da distribuição X.

24 É correto classificar a variável X  como uma variável quantitativa 
ordinal.

25 A mediana amostrai d eX é igual a 3.500.
26 O coeficiente de variação de Pearson da distribuição X é superior 

a 50%.

Considerando n tentativas independentes de invasão, em que 
n é u m  número fixo tal que n > 100, a probabilidade de 
haver um único sucesso é inferior a 0 ,99"''.

Considerando que o número de sucessos em 500 tentativas 
independentes de invasão seja representado por uma 
variável aleatória discreta W e que Y= 3 W -  10, os valores 
esperados de X e  de Y são iguais a 5.

Caso o total diário de tentativas de invasão seja uma 
variável aleatória representada por uma distribuição de 
Poisson com média igual a 100, o total diário de sucessos 
seguirá uma distribuição de Poisson com média e desvio 
padrão iguais a 1.

Considerando que uma seqüência de tentativas 
independentes de invasão ocorra, e que essas tentativas 
cessem quando há o primeiro sucesso, então a distribuição 
do número de tentativas independentes até a ocorrência do 
primeiro sucesso seguirá uma distribuição geométrica com 
desvio padrão inferior a 95.

RASCUNHO 1
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Para os itens de 31 a 38, serão consideradas como 
proposições apenas as sentenças declarativas, que mais facilmente são 
julgadas como verdadeiras —  V —  ou falsas —  F — , deixando de 
lado as sentenças interrogativas, exclamativas, imperativas e outras. 
As proposições serão representadas por letras maiúsculas do alfabeto: 
A, B, C etc. Para a formação de novas proposições, denominadas 
proposições compostas, a partir de outras, usam-se os conectivos “e”, 
“ou”, “se ..., então” e “se e somente se”, e o modificador “não”, ou 
“não é verdade que”, simbolizados, respectivamente, por: A, V, «-► 
e - 1. Dessa forma, AAB é lido como “A e B” ; AVB é lido como “A ou 
B” ; A->-B é lido como “se A, então B” ; A < ^ B é  lido como “A se e 
somente se B”, significando, nesse caso, que A->B e B->A; ^A é lido 
como “não A”. Uma proposição é simples quando, em sua formulação, 
não se emprega nenhum dos conectivos.

A cada proposição supõe-se associado um dos julgamentos 
V ou F, que se excluem. Para associar esses valores V ou F às 
proposições compostas, são usadas como critério as tabelas-verdades, 
como a seguir.

RASCUNHO

A B AAB AVB A->B A<>B -A
V V V V V V F
V F F V F F F
F V F V V F V
F F F F V V V

As proposições em que a tabela-verdade contém apenas V são 
denominadas tautologias, ou logicamente verdadeiras. Se a tabela- 
verdade contiver apenas F, a proposição é logicamente falsa.

Duas proposições A e B são equivalentes se suas tabelas- 
verdades forem iguais.

Tendo como referência as informações apresentadas, julgue os itens 
seguintes.

31 A proposição “Não precisa mais capturar nem digitar o código de 
barras” pode ser, simbolicamente, escrita como AAB, em que 
A é a proposição “Não precisa mais capturar o código de barras” 
e B é a proposição “Não precisa mais digitar o código de barras”.

32 As proposições “Não precisa mais capturar nem digitar o código 
de barras” e “Não precisa mais capturar ou digitar o código de 
barras” são equivalentes.

33 Considerando todas as possibilidades de julgamento V ou F das 
proposições simples que formam a proposição “Se Pedro for 
aprovado no concurso, então ele comprará uma bicicleta”, é 
correto afirmar que há apenas uma possibilidade de essa 
proposição ser verdadeira.

34 Considerando todas as possibilidades de julgamento V ou F das 
proposições simples que formam a proposição “O SERPRO 
processará as folhas de pagamento se e somente se seus 
servidores estiverem treinados para isso”, é correto afirmar que 
há apenas uma possibilidade de essa proposição ser julgada 
como V.

35 As proposições AAB->-AVB e AVB->-AAB são, ambas, 
tautologias.

36 Considere M  ■ uma matriz em que x pode assumir

qualquer valor real. Nesse caso, é correto afirmar que a 
proposição “Para algum número real x, a matriz M não será 
inversível” é uma proposição verdadeira.

37 Considere a seguinte proposição: “x, y  e z são números reais 
tais que x + y  + z = 1 e 2x + y  + z = 0”. Nesse caso, se 
essa proposição for V, então será V também a seguinte 
proposição: “x = -1 e y  + z  = 2” .
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Uma afirmação formada por um número fmito de proposições 

A„ A2, A,„ que tem como conseqüência outra proposição, B, é

denominada argumento. As proposições A„ A2, ..., A„ são as 

premissas, e B é a conclusão.

Se, em um argumento, a conclusão for verdadeira sempre que 

todas as premissas forem verdadeiras, então o argumento é 

denominado argumento válido.

Tendo como base essas informações, julgue o item abaixo.

38 O argumento formado pelas premissas

A„ A2, A3 = A,->-A2, A4 = A2 ^A, e pela conclusão 

B = A3AA4 é válido.

Os diagramas lógicos, também denominados diagramas de Euler- 

Venn, são utilizados como auxiliares na solução de problemas 

envolvendo conjuntos. São três os diagramas básicos.

um conjunto está 
te contido em outro.

os conjuntos têm alguns 
elementos em comum, 
mas não todos.

O : não há elementos comuns 
entre os conjuntos.

Com base nessas informações, julgue os itens a seguir.

39 Considere os conjuntos dos políticos, dos advogados e dos 

católicos. Nesse caso, o diagrama seguinte pode ser usado para 

descrever a relação entre esses conjuntos.

40 No Brasil, a relação entre eleitores, analfabetos e juizes pode ser 

representada pelo seguinte diagrama.

RASCUNHO
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This text refers to items from 41 to 50

1 The Capability Maturity Model (CMM) and the more
recent CMM Integrated have initiated a new discipline of 
engineering management that plays a dominant role in software

4 practice and research. The literature offers anumber ofsuccessful 
cases of how software firms adopted these models and the CMMs 
do indeed offer many useful recommendations for how to

7 systematically assess and improve software operations. The 
CMMs are, however, rooted in the ideal o f a rational, control- 
centered culture for software development, and although other

10 software process improvement (SPI) approaches have been 
suggested, they do not differ from the CMMs when it comes to 
underlying values. It is therefore not surprising that most software

13 firms struggle to take advantage o f the potential benefits o f SPI as 
they adoptthis technology into the complex and dynamic realities 
o f their day-to-day operations. 

w For small software firms, it is particularly challenging to
adopt SPI technology because the dominating approaches to SPI 
target large organizations; there are few resources available for

19 improvement in small software firms; it is by no means trivial 
tailoring SPI knowledge to their needs; and, because it normally 
takes several complex and expensive initiatives to reach new

22 maturity leveis. These challenges combined with sensitivity to 
highly dynamic environments require small software firms to seek 
altemative approaches to exploit the potential benefits of SPI

25 technology.

In te rn e t: <w w w .p a lg ra v e -jo u rn a ls .c o m >  (a d a p te d ) .
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According to the text it is correct to assert that

41 the Capability Maturity Model is likely to become the most 

recent integrated discipline of engineering management.

42 software firms have adopted CMMs successfully.

43 SPI technology is particularly suitable for small software 

firms.

44 the CMMs are quite unlike other software process 

improvement approaches in terms o f  their basic values.

Based on the linguistic structures of the text, judge the 

following items.

45 “indeed” (16) can be correctly replaced by in addition to.

46 “although” (19) is synonymous with even though.

47 “struggle” (113) means to make a determined effort.

48 “by no means” (119) is the same as otherwise.

49 the verb to tailor (120) is synonymous with to adapt.

50 “seek” (123) can be correctly replaced by mix.

RASCUNHO
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CONHECIMENTOS ESPECIFICO
A dinâmica que sustenta os processos projetual e teórico 

da atividade do design é embasada na dialética da forma e da 
função, que se expressa nas qualidades de beleza e eficiência. 
Assim, um objeto qualquer de design, seja ele um produto industrial 
ou uma peça de comunicação visual, para ser completo, deve ser 
bonito e funcionar bem. Interessantemente, funcionar bem é 
também uma forma de beleza, considerando que o mau 
funcionamento de um objeto é algo que incomoda e interfere 
negativamente na produção, nos processos e nas pessoas.

Eficiência, bom funcionamento e precisão isoladamente 
não garantem a determinado produto ou peça de comunicação o seu 
completo desempenho; design é, antes de qualquer coisa, uma 
forma de arte que apresenta os aspectos estéticos, plásticos e 
gráficos de um produto, que, para ser bom, deve funcionar bem, ser 
bonito e agradável.

Beleza relaciona-se com o apelo sensorial dos objetos e 
das imagens e tem por função chamar a atenção das pessoas por 
meio de um processo de comunicação visual em que qualidades 
formais, simbólicas, performáticas e informativas interagem.

Tendo como referência o texto acima, e considerando a 
multiplicidade de aspectos que ele evoca, julgue os itens a seguir.

51 Eficiência e beleza são igualmente importantes no design.

52 Para ser cult, um produto gráfico não deve ser funcional.

53 O projeto gráfico de um livro a respeito de sistemas 
computacionais não deve ter necessariamente preocupação 
com a estética.

54 Em um cartaz de divulgação de um espetáculo musical, as 
qualidades estéticas e funcionais devem estar harmonizadas.

55 Na tipografia, disciplina fundamental do design gráfico, 
atributos como legibilidade, conforto de leitura e visibilidade 
estão diretamente relacionados a aspectos estéticos do design.

56 O campo do design relacionado à arquitetura de informação 
objetiva promover maior acessibilidade aos usuários da rede 
mundial de computadores em geral, em uma clara manifestação 
do caráter funcionalista do design.

O design gráfico, também denominado programação 
visual, é uma atividade de design associada à comunicação social, 
que se manifesta na forma visual e, às vezes, audiovisual. A 
dialética da forma e função define também a atividade do design 
gráfico. Entretanto, como manifestação da comunicação, o design 
gráfico está impregnado de elementos específicos que o distinguem 
das demais atividades do design, fruto da união da semântica e da 
estética, ou seja, da união da palavra e da imagem. Para se 
estabelecer uma relação legítima de comunicação visual pelo design 
gráfico, três princípios são fundamentais: informar, identificar e 
persuadir.

É importante ressaltar o caráter onipresente desses 
princípios, pois eles coexistem, em maior ou menor grau, em toda 
e qualquer peça de comunicação visual, variando de acordo com o 
tema e a natureza de cada projeto.

Tendo o texto acima como referência inicial, julgue os itens de
57 a 65, relativos aos fundamentos do design gráfico.

Cargo 12: Analista -  Especialização: Programação Visual

57 Considerando os três princípios citados no texto, é correto 
afirmar que informar constitui elemento primordial na 
elaboração de um infográfico para um jornal diário.

58 Um calendário de caráter publicitário tem a função principal de 
identificar o patrocinador.

59 A persuasão é uma forma lícita de ludibriar o leitor de uma 
peça gráfica.

60 Em um livro essencialmente de texto, ou em um livro 
composto de imagens, o design gráfico deve-se basear no 
conceito de invisibilidade, ou seja, de que o design deve deixar 
transparecer o conteúdo da publicação.

61 As ilustrações, de modo geral, possuem caráter estritamente 
persuasivo.

62 O rótulo de um produto na gôndola de um supermercado deve 
conter, de forma equilibrada, os três princípios fundamentais 
do design, pois ele identifica o produto, fornece informações 
diversas e seduz o consumidor.

63 Texto e imagem são componentes fundamentais à prática do 
design gráfico.

64 O cartaz, seja ele publicitário, social ou cultural, apesar de ser 
uma importante peça gráfica de comunicação visual, não 
permite grande expressividade gráfica pelo uso da imagem.

65 O termo design gráfico refere-se à profissão dos 
comunicadores visuais, também denominada de programação 
visual, em que a palavra gráfico tem o significado primordial 
associado à arte de reproduzir por tipografia, gravura e 
estereotipia, entre outros meios.

Os conceitos de design gráfico são colocados à prova no exercício 
cotidiano do designer gráfico, em que um conjunto de habilidades 
é necessário para a prática profissional, entre elas o desenho, a 
fotografia, a reprodução gráfica, os sistemas de cor, a tipografia e 
a composição visual. Com relação aos elementos envolvidos no 
exercício cotidiano do design gráfico, julgue os itens subsequentes.

66 As cores primárias aditivas são o vermelho, o verde e o azul, 
e servem de base ao sistema RGB utilizado nos monitores e 
televisores.

67 As cores ciano, magenta e amarelo são denominadas de cores 
primárias subtrativas porque são obtidas a partir da retirada de 
um dos filtros das cores aditivas.

68 A linguagem visual no design editorial de uma publicação 
impressa é a mesma que em uma publicação na Internet.

69 No Brasil, os cartazes são comumente impressos em meia- 
folha do formato BB, ou seja, em folhas de papel de
48 cm x 66 cm.

70 Aplicativos gráficos como o Adobe Illustrator são apropriados 
para a elaboração de publicações como livros e livretos.

71 Uma imagem de tom contínuo, como uma foto em 
preto-e-branco, é reproduzida na impressão ofsete pelo uso de 
retículas de meio-tom.
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Com referência aos cartazes acima, julgue os itens a seguir.

72 O cartaz da figura II caracteriza-se por um design tipográfico que harmoniza expressividade e legibilidade.

73 No cartaz III, a tipografia manual e a ilustração interagem de forma expressiva.

74 Da composição simétrica e centralizada do cartaz IV e da leitura de seus elementos visuais, é correto afirmar que o objetivo principal 
do cartaz é evidenciar o destino da viagem transatlântica.

75 Em todos os cartazes, a ilustração tem uma função protagonista no leiaute, e a tipografia é predominantemente de caráter informativo.
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O uso de software livre incorporou ao vocabulário dos designers e profissionais das artes gráficas novas extensões de arquivos. 

Considerando os softwares livres GIMP, Inkscape e Scribus, julgue os próximos itens.

76 A extensão de arquivo .svg (scalable vector graphics) é usada para publicar imagens vetoriais na web.

77 O software GIMP não salva vetores como arquivos .svg.

78 O Inkscape gera arquivos com extensão .svg, o que permite o intercâmbio de objetos com o GIMP.

79 A extensão de arquivo .sht é a mais indicada para salvar imagens que serão utilizadas em uma diagramação de página no Scribus.
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Em relação às figuras acima e ao uso de comandos e ferramentas do software livre Inkscape, julgue os seguintes itens.

80 A figura I, que representa a união entre um quadrado e uma circunferência, pode ser obtida utilizando-se o comando path>union 
após a seleção dos dois objetos.

81 A figura II pode ser obtida utilizando-se os comandos Path>Combine, Path>Difference ou ainda o Path>Exclusion.

82 A figura III pode ser obtida utilizando-se o comando Path>lntersection.

83 Para apresentar o efeito blur, a figura IV precisa ser convertida em bitmap por meio do comando Path>Trace bitmap.
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Considerando a figura acima apresentada, julgue os itens a seguir, referentes ao software Inkscape.

84 A cor aplicada a um objeto, composta de 50% de C, 100% de M, 0 % de Y e 0% de K, corresponde a uma tonalidade entre o azul 
e o magenta.

85 No campo Blur, é possível configurar o esfumaçado nas bordas de uma figura.

86 Alpha e Opacity possuem a mesma função de tomar um objeto transparente.

Cargo 12: Analista -  Especialização: Programação Visual
-  8 -



UnB/CESPE -  SERPR0/C12

b b b k i m p ^

Considerando a figura acima, em que os espaços retangulares em 
branco presentes no menu do software GIMP formam a seqüência 
image>mode>decompose, julgue os itens subsequentes.

87 A opção decom pose permite extrair os canais de uma imagem, 
incluindo a opção CMYK.

88 A decomposição da imagem gera telas coloridas.

89 Cada uma das telas originadas no Decompose>CMYK 
corresponde a um canal de cor em RGB.

»~>-.ÇÇgr ,  3 «

Com referência à imagem acima apresentada, que mostra uma 
janela do GIMP, e a esse software, julgue os itens de 90 a 93.

90 A figura acima mostra a fusão de duas imagens. É possível 
alcançar esse resultado por meio do comando menu 
Filter>Com bine>Depth merge.
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91 No GIMP, foi possível conseguir a fusão das imagens 

utilizando o comando Calculations.

92 A imagem apresentada não deve ser utilizada em um sítio, já  

que as suas dimensões, assim como o tamanho do arquivo, são 

maiores que as comumente utilizadas na Web.

93 Antes de salvar a versão final da imagem, é necessário unir as 

duas camadas que a compõem por meio do comando 

Layer>Flatten image.

Para diagramar um documento, uma revista ou mesmo um livro, 

uma opção em software livre reconhecida pelos profissionais de 

design gráfico é o Scribus, também conhecido como scribus open 

source desktop publishing. A respeito desse software, julgue os 

itens que se seguem.

94 São conhecidos como desktop publishing  (DTP) os softwares 

que possuem ferramentas para organização de textos, que 

dialogam com software de tratamento de imagem e 

principalmente que oferecem opções de saída e finalização de 

arquivos.

95 Formulários, livros e textos trabalhados no Scribus podem ser 

convertidos em arquivos .pdf.

96 A linguagem JavaScript é importante para configuração de 

formulários criados no Scribus e que serão publicados na web.

97 A criação de uma página mestra é importante para que as 

características gerais do documento possam ser definidas para 

toda a sua extensão. Apesar disso, no Scribus é impossível 

converter uma página qualquer em página mestra.

Uma instituição disponibilizou em 1998 uma série de formulários 

online para seus clientes. Considerando que esses formulários ainda 

sejam atuais, julgue os itens a seguir, que abordam as dificuldades 

para baixá-los pela Internet.

98 Um arquivo com a extensão .tif não seria o mais indicado, pois 

ele armazena grande quantidade de informação, e o tamanho 

do arquivo aumentaria o tempo de transferência dessas 

informações na rede.

99 Devido à largura de banda disponível em 1998, de 14 Kbps, 

para a maioria da população, os arquivos feitos em software de 

diagramação podiam ser facilmente acessados e modificados 

pelos usuários.

100 A extensão .ps não deveria ser utilizada pelo grande público, 

pois essa extensão, ainda hoje, requer software específicos, 

disponíveis apenas em gráficas, editoras e locais similares.
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Ferramenta de fontes
Typekit
Tipografia online, finalmente.

Os designers há muito reclamam do estado da tipografia 
na Web. E eles estão certos, afinal de contas é muito limitador 
contar com apenas um punhado de fontes de sistema comuns a 
todos.

Felizmente a adoção da tag @font-face entre os 
navegadores atuais e a chegada do Typekit prometem mudar a 
situação.

O Typekit hospeda as fontes em seus servidores, e os 
associados carregam os arquivos com um simples código em 
JavaScript. Então é possível trabalhar com novas fontes 
normalmente, com a diferença de que há centenas de opções além 
das fontes padrão. O problema é o mesmo de sempre: o suporte e
implementação da tag @font-face ainda engatinha. E, como o
Typekit ainda é novo, há algumas questões técnicas que precisam 
ser resolvidas. O futuro, entretanto, parece ser brilhante. Logo a 
tipografia na Web será linda e editável.

R e v is ta  w w w .c o m .b r , a n o  10, n .° 117, ed . E u ro p a ,

a b r . / 2 0 1 0 ,  p .  8 2  ( c o m  a d a p t a ç õ e s ) .

Tendo como referência o texto acima e a multiplicidade de aspectos 
que ele evoca, julgue os itens a seguir.

101 Existem tags CSS que garantem que uma fonte possa ser 
escolhida dentro de um conjunto esperado, utilizando fontes de 
sistemas e fontes mais utilizadas. Embora essa solução não seja 
ideal, ela permite que a troca de fonte em computadores 
remotos seja controlável e o leiaute de uma página web não 
seja totalmente destruído.

102 O designer que adotar imediatamente o uso da tag descrita no 
texto pode produzir um sítio não acessível uma vez que o não 
reconhecimento do comando por todos os navegadores 
impediria a exibição da fonte e, portanto, do texto.

103 Até a invenção do Typekit, não existia nenhuma possibilidade 
de hospedar fontes na Web.

O autor Jakob Nielsen desenvolve há mais de uma década estudos 
sistemáticos acerca de navegabilidade, acessibilidade e usabilidade 
na web. Considerando o pensamento de Jakob Nielsen a respeito de 
usabilidade, julgue os próximos itens.

104 A capacidade de navegação em um sítio é importante para a 
usabilidade, sendo que as ações de buscar e localizar são 
responsáveis por mais de um terço das dificuldades dos 
usuários.

105 Localizabilidade, design de página, informação, suporte a 
tarefas e design espalhafatoso são itens que podem interferir na 
acessibilidade de uma página web, ao contrário dos bugs.

106 A fórmula elaborada para calcular o placar total de problemas 
de u sab ilidade  é rep resen tad a  pe la  exp ressão

TFP x TI x 7 t P / V IÕ , em que TFP, TI e TP correspondem, 
respectivamente, a taxa de frequência do problema, taxa de 
impacto e taxa de persistência.

107 Com relação a tipografia e legibilidade, o tamanho de texto 
recomendado para o público em geral é de 12 a 14 pixels.
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Acerca da elaboração de uma página web, julgue os itens 
subsequentes.

108 Um leiaute de página web em tabela é mais leve e mais 
acessível do que em CSS.

109 HTML, CSS, SVG e XML são linguagens e extensões 
denominadas web standards.

no O sistema hexadecimal de cores é a conversão de cores de luz 
RGB em cores de impressão CMYK e se expressa por 
combinações de dois dígitos, letras e números, para cada uma 
das cores básicas que compõe uma cor.

111 Ao criar-se um arquivo CSS, é possível declarar nele as 
principais características de uma página e chamar cada um dos 
estilos definidos no código HTML.

O W3C —  Consórcio World Wide Web —  é uma comunidade 
internacional que desenvolve padrões para a WWW com o objetivo 
de garantir o crescimento da Web. Considerando os padrões do 
W3C, julgue os itens que se seguem.

112 A principal função da WAI (web accessibility initiative) é 
tomar a Web acessível para as pessoas com deficiência.

113 Para a avaliação de acessibilidade de sítios na Web, o W3C 
disponibiliza em sua página um formulário no qual se pode 
digitar o endereço-teste de um sítio e, após aguardar alguns 
instantes, obter um relatório de acessibilidade e um selo de 
sítio acessível.

114 A extensão de arquivo .svg, gerada em software como o 
Inkscape, é indicada pelo W3C para publicação de vetores na 
Web.

115 Gráficos, código HTML e animações em .swf estão entre os 
padrões indicados para web design.

Poder usar a voz em computadores e mais especificamente na web 
é o sonho de muitos. Recentemente, Alfred Spector, pesquisador do 
Google, declarou que estão nascendo no Google Labs sistemas de 
busca por voz. Segundo ele, a voz é um dos maiores desafios 
tecnológicos em ciência da computação. Entretanto, para algumas 
pessoas, mais que desafio tecnológico, a possibilidade de traduzir 
um texto visual em som é a única forma de ter acesso aos conteúdos 
publicados na Internet. Com referência a essas informações e a 
leitores de tela, julgue os itens a seguir.

116 Um leitor de tela funciona traduzindo textos e imagens em 
som.

117 Considerando-se todas as informações necessárias, a adoção 
dos parâmetros de HTML e CSS e a elaboração do script das 
páginas permitem melhor identificação dos elementos e 
facilitam o trabalho de um leitor de tela. Um exemplo disso é
o uso d a  ta g  <i_mag alt= "breve descrição da 
imagem">.

118 Atualmente, o sistema IBM Via Voice é o único leitor de tela 
em português disponível para deficientes visuais.

119 Um leitor de tela que traduza os textos com a voz mais 
próximo da humana, evitando efeitos robóticos, diminui o 
estresse do usuário.

120 Um exemplo de uso de tag correto e sua interpretação pelos 
leitores de tela são as tags <b> e <strong>. Embora ambas 
produzam como efeito visual uma letra em negrito, a tag 
s t r ong acompanhada da codificação voc & # 7 8 6 9 significa ler 
com mais força ou ênfase.
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